TI Designs

コイン・セル・バッテリで10年以上のバッテリ寿命を実現したスター・
ネットワーク用の湿度/温度センサ・ノード

TI Designs リファレンス・デザイン

デザインの特長

TI Designs リファレンス・デザインは、システムの迅速な評
価とカスタム化に必要な方法、試験結果、設計ファイルなど
を提供しています。開発期間の短縮に役立ちます。

•

ナノパワー・システム・タイマの使用により、システムの間
欠動作が可能になり、CR2032 コイン・セルのバッテリ
寿命を 10 年以上に延長

デザイン・リソース

•

システムのウェイクアップ間隔を設定可能

•

非常に低いオフ状態の消費電流
(59.97秒で183nA)

•

低いアクティブ・プロセッサ電流と無線送信電流による、
オン状態での超低消費電流
(30msで4.04mA)

•

相対湿度の精度±2%

•

温度精度±0.2℃

TIDA-00374

デザイン・ファイルを含むツール・フォルダ

HDC1010
CC2650
TPL5110
TS5A3160
TPD1E10B06

プロダクト・フォルダ
プロダクト・フォルダ
プロダクト・フォルダ
プロダクト・フォルダ
プロダクト・フォルダ

E2Eエキスパートに質問
WEBENCH®設計支援ツール

CR2032
Coin Cell Battery

3.0 V

主なアプリケーション
•

産業用

•

モノのインターネット（IoT）

•

ビルディング・オートメーション

•

侵入検出

•

HVACセンサ

•

スマート・サーモスタットおよび室内監視

•

バッテリ駆動のシステム

TPL5110
(Nano-power
system timer)
MOS_DRV

TS5A3160
(Ultra-low leakage
load switch)
3.0 V

HDC1010
(Humidity and
Temp. Sensor)

I2C

CC2650
(ARM + MultiStandard 2.4 GHz)
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使用許可、知的財産、その他免責事項は、最終ページにあるIMPORTANT NOTICE(重要な注意事項）をご参照くださいますようお願いい
たします。 英語版のTI製品についての情報を翻訳したこの資料は、製品の概要を確認する目的で便宜的に提供しているものです。該当す
る正式な英語版の最新情報は、www.ti.comで閲覧でき、その内 容が常に優先されます。TIでは翻訳の正確性および妥当性につきましては
一切保証いたしません。実際の設計などの前には、必ず最新版の英語版をご参照くださいますようお願いいたします。
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Key System Specifications
表 1. Key System Specifications
PARAMETER

2

SPECIFICATION

DETAILS

Input power source

CR2032 Lithium-ion coin cell battery
(3.0-V nominal voltage)

2.5

Sensor type

Humidity and temperature

2.1

Measurement interval

One measurement per minute

Average on-state current consumption

4.04 mA

6.2.1

On-state duration

30.0 milliseconds

6.2.1

Average off-state current consumption

183.01 nA

6.2.2

Off-state duration

59.97 seconds

6.2.2

Estimated battery life

10.58 years

6.2.3

Radio transmission range

430 feet (see DETAILS for test conditions)

6.5

Operating temperature

–30°C to 60°C
(limited by CR2032 coin cell operating range)

2.5

Working environment

Indoor and outdoor

2.5

Form factor

1.5×1.5-inch square PCB

5.1

2
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System Description
Many industrial, building automation, and IoT systems require increasing numbers of wireless sensor endnodes. However, one of the major constraints of adding many wireless sensor end-nodes to a system is
power. Typical sensor end nodes are powered by batteries, which last from several months to several
years, depending on the power consumption of the end node. Replacing batteries can be a very
expensive system-level cost, because each end node would require a periodic manual battery
replacement.
Enabled by Texas Instruments’ nano-power system timer, SimpleLink™ ultra-low power wireless
microcontroller (MCU) platform, and humidity sensing technologies, the Humidity and Temperature Sensor
Node for Star Networks Enabling 10+ Year Coin Cell Battery Life TI Design demonstrates an ultra-low
power method to duty-cycle sensor end nodes leading to extremely long battery life.
At a high level, this TI Design system consists of a CR2032 coin cell battery, a nano-power system timer,
an ultra-low power wireless MCU, and a combined humidity and temperature sensor. The nano-power
system timer, which consumes tens of nanoamps when operating, controls power to all the remaining
circuitry. The nano-power system timer will switch on power to the system at a programmable interval (one
measurement per minute in this system), and when the wireless MCU has finished reading and
transmitting the sensor data, a signal to the system timer shuts down the entire system. By duty-cycling
the entire system in this manner, this TI Design achieves more than ten years of battery life from a
CR2032 coin cell.
This design guide addresses component selection, design theory, and test results of the TI Design
system. The scope of this design guide gives system designers a head-start in integrating TI’s nano-power
system timer, SimpleLink ultra-low power wireless MCU platform, and humidity sensing technologies into
their end-equipment systems.
The following sub-sections describe the various blocks within the TI Design system and what
characteristics are most critical to best implement the corresponding function.

2.1

Humidity and Temperature Sensor
In this TI Design, a digital humidity sensor with an integrated temperature sensor was chosen to
demonstrate the ultra-low power duty-cycling power scheme. Humidity and temperature are both common
measurements required in many industrial and building automation end-equipment systems. For example,
home heating and cooling systems of the future will likely include humidity and temperature
measurements in each individual room. With the wireless functionality of the system, this environmental
information is sent back to a smart thermostat, which will then control the various air ducts going to each
room, providing a much more intelligent home environment by providing individual comfort settings and
increasing energy savings.
With a relative humidity accuracy of ±2% and a temperature accuracy of ±0.2°C, the HDC1010 device
from Texas Instruments is ideally suited to accurately sense environmental information. The innovative
placement of the HDC1010 sensing element on the bottom of the device provides resistance to dust, dirt,
and other environmental contaminants, which improves system reliability for applications like heating,
ventilation, and air conditioning (HVAC) systems, smart thermostats, and room monitors. Furthermore, the
power consumption of the HDC1010 is extremely low, averaging 1.2 μA at one sample per second
measurement rate and interfacing to the device is straightforward with any microcontroller platform using
the I2C communication protocol.

コイン・セル・バッテリで10年以上のバッテリ寿命を実現したスター・ネットワーク用の
湿度/温度センサ・ノード
TIDU797 翻訳版 — 最新の英語版資料 http://www-s.ti.com/sc/techlit/TIDU797

JAJU197D – March 2015 – Revised May 2016

Copyright © 2015–2016, Texas Instruments Incorporated

3

System Description
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Ultra-Low Power Wireless MCU
In this TI Design, it is necessary to transmit the sensor information to some central location for processing.
However, because power consumption is always a concern in battery-based applications, the radio and
processor must be low power. Also, the wireless protocol required for the end-equipment system is an
important consideration for the selection of the radio device.
With TI’s SimpleLink ultra-low power wireless MCU platform, low power with a combined radio and MCU
enables extremely long battery life for sensor end nodes. Furthermore, the CC2650 device is a multistandard device, targeting Bluetooth® Smart, ZigBee® and 6LoWPAN, and ZigBee RF4CE remote control
applications. In this TI Design, Bluetooth Smart is the protocol of choice, but the hardware as built can
work with other protocols as well.

2.3

Nano-Power System Timer
This TI Design is able to achieve extremely long battery life by means of a nano-power system timer. This
type of device is intended to replace the internal timer of any standard microcontroller with a discrete
analog system timer that consumes much less power than the microcontroller’s internal timer. A nanopower system timer can be used either to bring an MCU out of sleep mode by means of a pin interrupt, or
to completely shut off power to the system, in whole, or in part.
In this TI Design, the TPL5110 device was chosen to shut off power completely to the entire system,
which reduces the off-state current drawn from the battery to the tens and hundreds of nanoamps. The
timer interval is user-selectable by means of a resistor, and can range from 100 ms up to two hours with a
typical time base accuracy of 1%. The TPL5110 device controls a low leakage analog switch, described in
2.4.

2.4

Low Leakage Analog Switch
In conjunction with a nano-power system timer, described in 2.3, this TI Design uses a low leakage
analog switch to shut off power to the entire system. The most important characteristic of this switch is the
off-state leakage, because that leakage will affect the overall battery life of the system significantly.
In this TI Design, the TS5A3160 device was chosen as the switch used to disconnect the system from the
battery. The TS5A3160 has a rated leakage current of ±20 nA at 25°C, which enables extremely long
battery life in this system.

2.5

Coin Cell Battery
The power source for this TI Design is a CR2032 lithium-ion coin cell. The selection of the CR2032 coin
cell battery as the power source was due to the ubiquity of that battery type, particularly in small form
factor systems, such as a sensor end node.
The voltage characteristics of a lithium-ion CR2032 coin cell battery are also ideal. The output voltage
remains relatively flat throughout the discharge life, until the cell is nearly depleted. At that time, the output
voltage drops off relatively quickly.
The temperature characteristics of lithium-ion batteries are also superior to that of alkaline cells,
particularly at lower temperatures. This is due to lithium-ion cells having a non-aqueous electrolyte that
performs better than aqueous electrolytes commonly found in alkaline batteries.

4

コイン・セル・バッテリで10年以上のバッテリ寿命を実現したスター・ネットワーク用の
JAJU197D – March 2015 – Revised May 2016
湿度/温度センサ・ノード
TIDU797 翻訳版 — 最新の英語版資料 http://www-s.ti.com/sc/techlit/TIDU797
Copyright © 2015–2016, Texas Instruments Incorporated

System Description

www.tij.co.jp

However, the CR2032 coin cell battery is still the limiting component in terms of operating temperature
range; all of the integrated circuits and other electrical components are specified to operate at a wider
temperature range than the battery. Therefore, the specified operating temperature range of the TI Design
system is –30°C to 60°C. Given an appropriate weather-proof enclosure, this TI Design system is suited
for both indoor and outdoor use.
Immediately following the battery is a low forward voltage Schottky diode, a current limiting resistor, and a
bulk capacitor. The Schottky diode prevents damage to the hardware if the coin cell battery is inserted
backwards. The current limiting resistor in conjunction with the bulk capacitor reduces the current spikes
drawn from the battery when the system transitions from off-state to on-state. The bulk capacitor is also
sized to prevent too much voltage from being dropped across the current limiting resistor during the onstate.
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Block Diagram

CR2032
Coin Cell Battery

3.0 V

TPL5110
(Nano-power
system timer)
MOS_DRV

TS5A3160
(Ultra-low leakage
load switch)
3.0 V

HDC1010
(Humidity and
Temp. Sensor)

I2C

CC2650
(ARM + MultiStandard 2.4 GHz)
Copyright © 2016, Texas Instruments Incorporated

図 1. System Block Diagram

3.1

Highlighted Products
The Humidity and Temperature Sensor Node for Star Networks Enabling 10+ Year Coin Cell Battery Life
Reference Design features the following devices:
•

HDC1010 ( 3.1.1): Low power, high accuracy digital humidity sensor with integrated temperature
sensor

•

CC2650 ( 3.1.2): SimpleLink multi-standard 2.4 GHz ultra-low power wireless MCU

•

TPL5110 ( 3.1.3): Ultra–low-power timer with MOS driver and MOSFET Power ON

•

TS5A3160 ( 3.1.4): 1-Ω SPDT analog switch 5-V/3.3-V single-channel 2:1 multiplexer/demultiplexer

•

TPD1E10B06 ( 3.1.5): Single-channel ESD in a 0402 package with 10-pF capacitance
and 6-V breakdown

For more information on each of these devices, see the respective product folders at www.ti.com.
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3.1.1

HDC1010
The HDC1010 is a digital humidity sensor with integrated temperature sensor that provides excellent
measurement accuracy at very low power. The HDC1010 operates over a wide supply range, and is a low
cost, low power alternative to competitive solutions in a wide range of common applications. The
innovative Wafer Level Chip Scale Package (WLCSP) simplifies board design with the use of an ultracompact package. The sensing element of the HDC1010 is placed on the bottom part of the device, which
makes the HDC1010 more robust against dirt, dust, and other environmental contaminants. The humidity
and temperature sensors are factory calibrated and the calibration data is stored in the on-chip nonvolatile memory.
3.3 V
RH

HDC1010

3.3 V

VDD

Registers
and
Logic

ADC

3.3 V

I2C

MCU

SDA
SCL
DRDYn
ADR0
ADR1

VDD

2

IC
Peripheral
GPIO

OTP
Calibration Coefficients

TEMPERATURE

GND

GND

Copyright © 2016, Texas Instruments Incorporated

図 2. HDC1010 Functional Block Diagram
Features:
•

Relative humidity accuracy ±2% (typical)

•

Temperature accuracy ±0.2°C (typical)

•

Excellent stability at high humidity

•

14-bit measurement resolution

•

100-nA sleep mode current

•

Average supply current:
– 710 nA at 1 sps, 11-bit RH measurement
– 1.3 µA at 1 sps, 11-bit RH and temperature measurement

•

Supply voltage 2.7 to 5.5 V

•

Tiny 2-mm×1.6-mm device footprint

•

I2C interface
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CC2650
The CC2650 is a wireless MCU targeting Bluetooth Smart, ZigBee and 6LoWPAN, and ZigBee RF4CE
remote control applications.
The device is a member of the CC26xx family of cost-effective, ultra-low power, 2.4-GHz RF devices. Very
low active RF and MCU current and low-power mode current consumption provides excellent battery
lifetime and allows operation on small coin cell batteries and in energy-harvesting applications.
The CC2650 contains a 32-bit ARM Cortex®-M3 running at 48-MHz as the main processor and a rich
peripheral feature set, including a unique ultra-low power sensor controller, ideal for interfacing external
sensors or collecting analog and digital data autonomously while the rest of the system is in sleep mode.
This makes the CC2650 ideal for applications within a whole range of products including industrial,
consumer electronics, and medical.
The Bluetooth Low Energy controller and the IEEE 802.15.4 MAC are embedded into ROM and are partly
running on a separate ARM Cortex-M0 processor. This architecture improves overall system performance
and power consumption and frees up flash memory for the application.
The Bluetooth Smart and ZigBee stacks are available free of charge from www.ti.com.
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SimpleLinkTM CC26xx wireless MCU
RF core

cJTAG
Main CPU
ROM

ADC
ADC

ARM®

128KB
Flash

Cortex®-M3

8KB
cache

Digital PLL
DSP modem
4KB
SRAM

ARM®
20KB
SRAM

Cortex®-M0
ROM

Sensor controller

General peripherals / modules
I2C

4× 32-bit Timers

UART

2× SSI (SPI, µW, TI)

Sensor controller
engine

12-bit ADC, 200 ks/s
Watchdog timer

I2S

2x comparator
10 / 15 / 31 GPIOs

TRNG
SPI-I2C digital sensor IF

AES

Temp. / batt. monitor

Constant current source
RTC

32 ch. µDMA

Time-to-digital converter
2KB SRAM

DC-DC converter
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図 3. CC2650 Functional Block Diagram
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Features:
•

Microcontroller
– Powerful ARM Cortex-M3
– EEMBC CoreMark® score: 142
– Up to 48-MHz clock speed
– 128 KB of in-system programmable flash
– 8-KB SRAM for cache
– 20-KB ultra-low leakage SRAM
– 2-Pin cJTAG and JTAG debugging
– Supports over-the-air (OTA) upgrade

•

Ultra-low power sensor controller
– Can run autonomous from the rest of the system
– 16-bit architecture
– 2-KB ultra-low leakage SRAM for code and data

•

Efficient code size architecture, placing drivers, Bluetooth low energy controller, IEEE 802.15.4 MAC,
and bootloader in ROM

•

RoHS-compliant packages
– 4×4-mm RSM QFN32 (10 GPIOs)
– 5×5-mm RHB QFN32 (15 GPIOs)
– 7×7-mm RGZ QFN48 (31 GPIOs)

•

Peripherals
– All digital peripheral pins can be routed to any GPIO
– 4 general-purpose timer modules (8 × 16-bit or 4 × 32-bit timer, PWM each)
– 12-bit ADC, 200-k samples per second, 8-channel analog MUX
– Continuous time comparator
– Ultra-low power analog comparator
– Programmable current source
– UART
– 2× SSI (SPI, µW, TI)
– I2C
– I2S
– Real-time clock (RTC)
– AES-128 security module
– True random number generator (TRNG)
– 10, 15, or 31 GPIOs, depending on package option
– Support for eight capacitive sensing buttons
– Integrated temperature sensor

•
10

External system
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– On-chip internal DC-DC converter
– Very few external components
– Seamless integration with the SimpleLink CC2590 and CC2592 range extenders
– Pin compatible with the SimpleLink CC13xx in 4×4-mm and 5×5-mm QFN packages
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Low power
– Wide supply voltage range
•

Normal operation: 1.8 to 3.8 V

•

External regulator mode: 1.7 to 1.95 V

– Active-mode RX: 5.9 mA
– Active-mode TX at 0 dBm: 6.1 mA
– Active-mode TX at 5 dBm: 9.1 mA
– Active-mode MCU: 61 µA/MHz
– Active-mode MCU: 48.5 CoreMark/mA
– Active-mode sensor controller: 8.2 µA/MHz
– Standby: 1 µA (RTC running and RAM/CPU retention)
– Shutdown: 100 nA (wakeup on external events)
•

RF section
– 2.4-GHz RF transceiver compatible with BLE 4.1 specification and IEEE 802.15.4 PHY and MAC
– Excellent receiver sensitivity (–97 dBm for BLE and –100 dBm for 802.15.4), selectivity, and
blocking performance
– Programmable output power up to 5 dBm
– Single-ended or differential RF interface
– Suitable for systems targeting compliance with worldwide radio frequency regulations

•

•

ETSI EN 300 328 (Europe)

•

EN 300 440 Class 2 (Europe)

•

FCC CFR47 Part 15 (US)

•

ARIB STD-T66 (Japan)

Tools and development environment
– Full-feature and low-cost development kits
– Multiple reference designs for different RF configurations
– Packet sniffer PC software
– Sensor controller studio
– SmartRF™ studio
– SmartRF flash programmer 2
– IAR Embedded Workbench® for ARM®
– Code Composer Studio™
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3.1.3

TPL5110
The TPL5110 Nano-Power System Timer is a low power timer with an integrated MOSFET driver ideal for
power gating in duty cycled or battery powered applications. Consuming only 35 nA, the TPL5110 can
enable the power supply line and drastically reduce the overall system stand by current during the sleep
time. Such power savings enable the use of significantly smaller batteries making it well suited for energy
harvesting or wireless sensor applications. The TPL5110 provides selectable timing intervals from 100 ms
to 7200 s and is designed for power gating applications. In addition, the TPL5110 has a unique one-shot
feature where the timer will only power the MOSFET for one cycle. The TPL5110 is available in a 6-pin
SOT23 package.
VDD

EN/
ONE_SHOT

LOW FREQUENCY
OSCILLATOR

FREQUENCY
DIVIDER

LOGIC
CONTROL

DRV
DONE

DELAY/
M_DRV

DECODER
&
MANUAL RESET
DETECTOR

GND

図 4. TPL5110 Functional Block Diagram
Features:
•

Supply voltage: 1.8 to 5.5 V

•

Current consumption: 2.5 V, 35 nA (typ)

•

Selectable time intervals: 100 ms to 7200 s

•

Timer accuracy: 1% (typ)

•

Resistor selectable time interval

•

Manual MOSFET power on

•

One-shot feature
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TS5A3160
The TS5A3160 is a single-pole double-throw (SPDT) analog switch that is designed to operate from 1.65
to 5.5 V. The device offers a low ON-state resistance and an excellent channel-to-channel ON-state
resistance matching. The device has excellent total harmonic distortion (THD) performance and consumes
very low power. These features make this device suitable for portable audio applications.
NO 1

6

IN

GND 2

5

V+

NC 3

4 COM

図 5. TS5A3160 Package Diagram
Features:
•

Isolation in the powered-off mode, V+ = 0

•

Specified make-before-break switching

•

Low ON-state resistance (1 Ω)

•

Control inputs are 5.5-V tolerant

•

Low charge injection

•

Excellent ON-state resistance matching

•

Low THD

•

1.65- to 5.5-V single-supply operation

•

Latch-up performance exceeds 100 mA Per JESD 78, Class II

•

ESD performance tested per JESD 22
– 2000-V human-body model
(A114-B, Class II)
– 1000-V charged-device model (C101)
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3.1.5

TPD1E10B06
The TPD1E10B06 is a single channel ESD protection device in a small 0402 package. The device offers
over ±30-KV IEC air-gap, over ±30-KV contact ESD protection, and has an ESD clamp circuit with a backto-back diode for bipolar or bidirectional signal support. The 10-pF line capacitance is suitable for a wide
range of applications supporting data rates up to 400 Mbps. Typical application areas of the TPD1E10B06
include audio lines (microphone, earphone and speaker phone), SD interfacing, keypad or other buttons,
and VBUS pins of USB ports (ID).
The 0402 package is industry standard and convenient for component placement in space saving
applications. The TPD1E10B06 is characterized for operation over ambient air temperature of –40°C to
125°C.

1

2

図 6. TPD1E10B06 Device Configuration
Features:
•

Provides system-level ESD protection for low-voltage I/O interface

•

IEC 61000-4-2 Level 4
– >±30kV (air-gap discharge)
– >±30kV (contact discharge)

•

IEC 61000-4-5 (Surge): 6 A (8/20 μs)

•

I/O capacitance: 12 pF (typical)

•

RDYN: 0.4 Ω (typical)

•

DC breakdown voltage: ±6 V (min)

•

Ultra-low leakage current: 100 nA (max)

•

10-V clamping voltage (max at IPP = 1 A)

•

Industrial temperature range: –40°C to 125°C

•

Space-saving 0402 footprint (1 × 0.6 × 0.5 mm)
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System Design Theory and Considerations
The Humidity and Temperature Sensor Node for Star Networks Enabling 10+ Year Coin Cell Battery Life
TI Design measures the ambient relative humidity and temperature and achieves an extremely long
battery life through the use of duty-cycling with a nano-power system timer. The TPL5110 device controls
when the TS5A3160 device switches the battery on and off to the entire system. Because the on-state, or
the time when the CC2650 and HDC1010 have power, is very short, and the off-state current consumption
from the coin cell battery is very low, the estimated battery life is very long.

4.1

Duty-Cycled Power Design Theory
The main parameters that affect the estimated battery life of the entire system are:
•

Capacity rating of the battery in milliamp-hours (mAh)

•

Average off-state current consumption (nA)

•

Off-state durations

•

Average on-state current consumption (mA)

•

On-state durations

式 1 describes the estimated battery life of the system in units most convenient to this TI Design:
Battery capacity (mAh )
1 year
Battery life (years) =
´
´ 85% derating factor
æ I (mA ) ´ t (s ) + I (nA ) ´ t (s ) ´ 10-6 ö 8760 hours
on
off
off
ç on
÷
ç
÷
t on (s ) + t off (s )
è
ø
(1)

(

)

Based on 式 1, optimizing several factors will lead to a longer battery life:
•

Longer toff

•

Shorter ton

•

Lower Ion

•

Lower Ioff

toff is completely controllable by the end user. In this TI Design, a value of 1 minute was chosen for the
TPL5110 wakeup interval, leading to Toff of the following form:
t off = 1 minute - t on
(2)
式 2 indicates that the system will wake up once a minute to measure the ambient relative humidity and
temperature and transmit a Bluetooth Smart packet with that data.
ton is somewhat less controllable, because there is some minimum amount of time required to power up
the system, take the measurement from the HDC1010 device, transmit the packet, and shut down again.
The HDC1010 device has a specified twait after power up before anything can be done, along with a tconv,
which is the time it takes to convert the humidity and temperature measurements. There is also the time
required to perform the I2C transactions between the CC2650 and HDC1010 devices as well as the time it
takes to transmit the data packet from the CC2650 device.
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Ion is defined as the average current consumed from the battery during the on-state. The majority of this
current is attributed to the CC2650 device. The main processor core of the CC2650 device is running at
48 MHz. However, the CC26xx line of SimpleLink ultra-low power wireless MCUs is especially designed to
consume very little current, even during radio transmission. At 0-dBm transmit power, the CC2650 is
specified to consume a typical 6.1 mA of current, well below other available wireless microcontrollers. The
HDC1010 device also consumes current during the on-state, but the amount is minimal compared to the
CC2650 device.
Ioff is defined as the average current consumed from the battery during the off-state. This current is
comprised primarily of the leakage through the TS5A3160 analog switch, the operating current of the
TPL5110 nano-power system timer, and the current required to re-charge the bulk capacitor that is placed
near the CR2032 coin cell battery, as well as the steady-state leakage current through that same bulk
capacitor.
In this TI Design, the bulk capacitor near the coin cell battery is required to prevent voltage sag during the
on-state, and recharging itself from the battery during the off-state. However, this means that the bulk
capacitor is connected to the coin cell battery all the time, and thus, must have a very low leakage current.
The exact capacitor chosen for this system is manufactured by TDK Corporation (part number:
C3216X5R1A107M160AC), and has a measured leakage current of 8.33 nA with 3.0-V applied voltage, as
measured by TDK Corporation engineers. The value of 100 μF was chosen to provide adequate energy
storage to handle the on-state current requirements of the CC2650 and HDC1010 devices.
6.2 has more details about the battery life performance of this TI Design.

4.2

Wireless Network Design Theory
Because the power is completely cut off from the CC2650 wireless MCU, this TI Design is intended to be
used in a star network configuration. This means that each sensor end-node connects directly to a central
receiver, which receives the data from each end-node, and then performs any necessary processing and
connection to the cloud. This implies that this TI Design is not intended for use in smart mesh networks,
because the wireless microcontroller will not retain its state or have any control over when it wakes up.
The TI Design as released sends out non-connectable advertisement packets that contain four bytes of
data: two bytes of temperature data and two bytes of relative humidity data. This data is transmitted
directly as the HDC1010 device outputs it; no post-processing or correction is implemented on the
CC2650 device itself.
The antenna on this TI Design is the small size 2.4-GHz PCB antenna. See the application note AN043[6]
for more details about layout and performance.

4.3

Firmware Control
The firmware for this TI Design is based on the packet error rate (PER) test software program. This
program is demo software that is primarily used to perform radio power benchmarking, range testing, and
multi-protocol testing. The PER test software is built on TI-RTOS, and has been modified to send out nonconnectable Bluetooth Smart advertisement packets. These packets contain four bytes of data directly
from the HDC1010 device. I2C drivers have also been added to the PER test software to enable
communication with the HDC1010 device.
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Finally, after the packet with the HDC1010 data has been sent, the CC2650 device is programmed to pull
a GPIO high; this GPIO is connected to the DONE pin of the TPL5110 device. When the TPL5110 device
receives a high level on the DONE pin, the TS5A3160 device is signaled to open the connection between
the coin cell battery and the rest of the circuit.
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5

Getting Started

5.1

Hardware Overview
The Humidity and Temperature Sensor Node for Star Networks Enabling 10+ Year Coin Cell Battery Life
TI Design hardware is shown in 図 7 and 図 8. The PCB is in a 1.5×1.5-inch square form factor, and
comes with 0.5-inch nylon standoffs to ensure ease of use while performing lab measurements.

図 7. Humidity and Temperature Sensor Node for Star
Networks Enabling 10+ Year Coin Cell Battery Life
Reference Design Hardware (Top View)

図 8. Humidity and Temperature Sensor Node for Star
Networks Enabling 10+ Year Coin Cell Battery Life
Reference Design Hardware (Bottom View)

All of the integrated circuits (CC2650, TPL5110, TS5A3160, and HDC1010) are located on the top side of
the PCB. The 2.4-GHz antenna is also located on the top side of the PCB.
The bottom side of the PCB contains the CR2032 coin cell battery holder; several test points and jumpers
as well as the ESD protection devices for the programming header.
There are four unused GPIOs that have been brought out from the CC2650 device to an unpopulated
header to facilitate future prototyping and debugging.
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Loading the Firmware
The firmware used on this TI Design was developed using TI's Code Composer Studio software (version
6.1.0). The IAR Embedded Workbench for ARM also supports the CC26xx line of SimpleLink products
(www.iar.com).
To program or debug the TI Design hardware, it is necessary to close J2 with a jumper shunt; this
bypasses the TS5A3160 analog switch. If J2 is left open, then the TPL5110 device will continue to control
the power of the CC2650 device, preventing proper programming and debugging.
Also, it is necessary to power the board from 3.0 V, supplied at pin 2 of J1. Connecting the external power
source at this location bypasses the Schottky diode and current limiting resistor. If power is supplied
directly at the battery holder, either from a coin cell or a bench power supply, the CC2650 device will likely
draw enough current during programming to drop the supply voltage because of the Schottky diode and
current limiting resistor, which will likely result in the CC2650 device becoming "bricked" or unusable.
注:

For programming the TI Design hardware, shunt J2 and provide 3.0 V at pin 2 of J1. See 図
9 for a photo of the correct setup for programming or debugging the TI Designs hardware.

図 9. Configuration of Jumpers and Power for Programming and Debugging
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The TI Design hardware is programmed by connecting the 10-pin mini ribbon cable from J6 to the
SmartRF06 Evaluation Board (10-pin ARM Cortex Debug Connector, P418). See 図 10 for a photo of the
correct setup for connecting the TI Designs hardware to the SmartRF06 evaluation board.

図 10. Connection of SmartRF06 Evaluation Board and TI Designs Hardware for Programming/Debugging
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Receiving Data Packets Using CC2540EMK-USB and SmartRF Protocol Packet Sniffer
As described elsewhere, this TI Design is programmed to read the relative humidity and temperature data
from the HDC1010 device, and then broadcast that data as a Bluetooth Smart non-connectable
advertisement packet. The data payload consists of two bytes of temperature data, followed by two bytes
of relative humidity data.
To verify the proper operation of the radio transmission, the CC2540EMK-USB CC2540 USB Evaluation
Module Kit is used to "sniff" packets using the SmartRF Protocol Packet Sniffer software. After installing
the Packet Sniffer software (v2.18.1 at the time of writing), the procedure is as follows to detect the data
transmissions:
1. Plug the CC2540EMK-USB into an unused USB port on the computer with the Packet Sniffer software
installed.
2. Open the Packet Sniffer software; choose "Bluetooth Low Energy" as the protocol and hit Start.

図 11. Packet Sniffer Start-up Dialog
3. Click the "Radio Configuration" tab on the bottom toolbar and select "39" for the Advertising Channel.
4. Press the Play button on the top toolbar to initiate the packet capture process.
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5. There will likely be many other packets detected, probably from mobile phones and other devices that
use the Bluetooth Smart protocol. To view only the packets sent from the TI Design hardware, apply a
display filter. 図 12 shows a sample display of what will be recorded with no filter applied. The
highlighted row shows the desired data packet in the midst of other, undesired data packets.

図 12. Packet Sniffer With No Display Filter Applied
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6. The appropriate filter checks for non-connectable advertisement packets with ADV_NONCONN AdvA
field equal to 0x264026402640. In Field Name, select "ADV_NONCONN AdvA" from the drop down
options. Click the First button. Modify the filter condition to the correct address, hit Add, and then click
Apply filter. 図 13 shows an example filtered view.

図 13. Packet Sniffer With Appropriate Display Filter Applied
7. To export the captured, filtered packets, press the Save the current session button on the toolbar, or
pause the packet capture and click File → Save data…; either of these choices will prompt to save the
displayed data as a packet sniffer data (.psd) file.
8. Using the HxD (http://mh-nexus.de/en/hxd/) hex editor software, open the .psd file. Click View → Bytes
per Row, and enter "271"; click Ok. A different hex editor may perform this function as well; however,
the authors of this document have not verified any other options.
9. Click File → Export → Editor View; this produces a text file that can then be imported into Microsoft®
Excel® for further analysis. For more information on the sniffer data packet format, click Help → User
Manual on the Packet Sniffer software.
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6

6.1

Test Data
注:

Unless otherwise noted, the test data in the following sections was measured with the
system at room temperature.

注:

All of the measurements in this section were measured with calibrated lab equipment.

Overview
The Humidity and Temperature Sensor Node for Star Networks Enabling 10+ Year Coin Cell Battery Life
TI Design has been characterized for functional usage including power consumption, relative humidity
performance, temperature performance, and radio transmission range.
The results of testing and characterization are shown in the following sections. Any plots of the HDC1010
device’s output data was produced using data packets captured using a CC2540EMK-USB evaluation
module kit and SmartRF Protocol Packet Sniffer software, as described in 5.3, with data formatting and
analysis performed using Microsoft Excel.

6.2

Power Consumption
Because the primary purpose of this TI Design is to showcase a power topology for battery-powered
wireless sensor end-nodes, characterization of the system’s power consumption is critical.
As described in 4.1, there are two states that this TI Design system is in: on-state and off-state. Both the
duration and the average current of each state are factors in estimating the total battery life of the TI
Design system.
The on-state consists of the timer interval of the TPL5110 expiring, resulting in the TS5A3160 analog
switch connecting the battery to the rest of the system. The CC2650 device receives power,
communicates with the HDC1010 device using I2C, receives the current temperature and relative humidity
information, transmits a non-connectable advertisement packet with that data, and then signals the
TPL5110 that the system can be shut back down.
The off-state consists of the rest of the system (CC2650 and HDC1010) being completely disconnected
from the coin cell battery by means of the TS5A3160 analog switch. The sources of off-state current
consumption from the coin cell battery are the recharging and leakage currents due to the bulk capacitor
near the coin cell, the operating current of the TPL5110 nano-power system timer device, and the leakage
current due to the TS5A3160 analog switch.
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On-State Power Characterization
The on-state duration and average current was characterized with the use of a Tektronix MDO3024 Mixed
Domain oscilloscope and a Tektronix TCP0030A current probe. The oscilloscope was connected directly
to a laptop through a USB cable with the corresponding software to directly export the recorded data
points. Figure 11 shows the current drawn from the coin cell battery, as measured through jumper J1.
Because there is the 100-μF bulk capacitor and 12.1-Ω resistor in series with the battery, the current
profile has a slight low-pass filtered effect.
7
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図 14. On-State Current versus Time
At time t = 0 ms, the TPL5110 device has activated, and immediately the current jumps up to about
6.5 mA. The current draw then quickly settles to approximately 5 mA for the remainder of the on-state.
At about time t = 24 ms, the current drawn from the battery starts to decay in an RC-sort of pattern, which
is due to the recharging of the bulk capacitor, which has been providing energy to the CC2650 and
HDC1010 devices during the on-state. This is the point at which the TPL5110 device has been given the
DONE signal by the CC2650 device, indicating that the system has successfully transmitted the data
packet containing the HDC1010 device output data.
The on-state is considered complete at 30 ms, when the current level drops below the accuracy of the
current probe in use. By exporting the data into Excel for analysis, it was determined that the average
current over the first 30 ms of system operation was 4.038 mA. This is considered the average on-state
current of the TI Design system.
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6.2.2

Off-State Power Characterization
The off-state duration and average current was characterized with the use of a Keysight (Agilent) 34401A
Digital Multimeter (DMM) with 6½ digits of resolution. The DMM was connected directly to a laptop with
the corresponding software to directly export the recorded data points. 図 15 shows the current drawn
from the coin cell battery as measured through jumper J1.
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図 15. Off-State Current versus Time
The data has been plotted logarithmically on both the x and y axes because the first portion of the plot,
labeled "Region 1", has a much higher current and shorter time duration than that of "Region 2".
Region 1 is actually the portion of the off-state where the bulk capacitor is continuing to recharge directly
from the coin cell. The first data point occurs at approximately 45 ms after the system first powers up, and
then is essentially complete after 10 seconds. The average current over Region 1 is 890.03 nA.
The off-state current during Region 2 is dominated by the operating current of the TPL5110 device, which
is specified to have a typical value of 35 nA, and a maximum value of 50 nA with a supply current of
2.5 V. The supply current in this TI Design system is nominally 3.0 V, and in practice can be somewhat
higher (3.2 to 3.3 V), depending on the age of the coin cell in use. As mentioned previously, the leakage
current of both the bulk capacitor (~8.33 nA) and the TS5A3160 analog switch (±20 nA) will also
contribute to the off-state current during Region 2. Given the expected values of the sources of off-state
current, the measured average value of 41.60 nA during Region 2 is quite reasonable.
Averaged over the entire duration of Regions 1 and 2, the off-state current is equal to 183.01 nA, and lasts
for a duration of 1 minute – 30 ms = 59.970 seconds.
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Estimated Battery Life Calculations
As shown in 4.1, 式 1, used for estimating battery life of the TI Design system, has five parameters:
•

Capacity rating of the battery in milliamp-hours (mAh)

•

Average off-state current consumption (nA)

•

Off-state duration (s)

•

Average on-state current consumption (mA)

•

On-state duration (s)

The battery used in this TI Design, as stated previously, is a CR2032 lithium-ion coin cell, which has a
capacity rating of 240 mAh. There is a built-in de-rating factor of 85%, which attempts to model the effects
of varying temperatures, as well as battery self-leakage.
When using the measured values for the remaining parameters, the battery life calculation appears as 式
3:
240 mAh
1 year
Battery Life (years) =
´
´ 85% = 10.58 years
6
æ 4.038 mA ´ 0.03 s + 183.01 nA ´ 59.97 s ´ 10 ö 8760 hours
çç
÷÷
0.03 s + 59.97 s
è
ø
(3)

This battery calculation has one caveat: the estimated battery life uses the value of 240 mAh for battery
capacity. According to the Energizer CR2032 datasheet, this lifetime is calculated by the capacity at which
the battery voltage drops to 2.0 V. However, in the current system, the HDC1010 device has a minimum
rated voltage of 2.7 V. Therefore, the actual capacity of this system is more approximately 200 mAh,
which leads to an estimated battery life of 8.81 years.
The result of this finding is that it is most desirable to have all components, including the sensor and any
required analog front-end work down to 1.8 V. This enables a complete depletion of the coin cell battery,
ensuring the longest possible battery life.
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6.2.4

Duty-Cycled System Tradeoffs
This TI Design is based around the concept that by duty-cycling the system with a nano-power system
timer, the off-state current can be lowered beyond that of what any inherent sleep mode of the remaining
components can achieve. It follows that a comparison between a system using this concept and one that
does not use this concept would be valuable, because there are various situations where either system
topology could make sense.
If it is assumed that the on-state current and duration remain fixed for both types of system topologies, it is
possible to compare the two. By varying the wakeup interval, there will be certain scenarios where it
makes more sense to use the built-in standby mode of the CC2650 device, rather than using the TPL5110
device. The assumption is that by using the built-in standby mode of the CC2650 device, the off-state
current goes from 183.01 nA up to approximately 1 μA. Also, a reference line is displayed with a level of
10 years, a common shelf life of coin cell batteries.
30
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図 16. Estimated Battery Life Comparison: TPL5110 Nano-Power System Timer versus CC2650 Standby
Mode
However, as 図 16 shows, the system using the TPL5110 device to duty-cycle the system will always have
a better estimated battery life. The only scenario where the use of a TPL5110 device to create a dutycycled sensor end-node is not practical is if the wireless network is a sleeping mesh network. In this case,
the CC2650 device would need to be in control of its own sleep state to maintain network
communications. Furthermore, additional load switches would likely need to be added to the system to
ensure that quiescent or standby currents of any other sensors or devices in the system are minimized
during the off-state, which could potentially increase the system cost and complexity.
That being said, once the wakeup interval exceeds approximately two minutes, both methods should
provide more than enough battery life to exceed the typical battery shelf life of 10 years, which is common
to many coin cell vendors.
If the end-equipment system has different requirements for the on-state current and duration, this
calculation could change significantly, and these calculations should be re-run to see what sort of system
topology makes the most sense to achieve the longest battery life possible.
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Relative Humidity Characterization
This TI Design exemplifies the concept of a duty-cycled sensor end node through the use of the HDC1010
device, which measures both relative humidity and temperature.
To get an idea of how the TI Design system responded to varying relative humidity levels, the hardware
was placed in a Thunder Scientific Model 2500 Benchtop Humidity Generator
(http://www.thunderscientific.com/) with a brand new Energizer® CR2032 lithium-ion coin cell battery. The
CC2540EMK-USB CC2540 USB Evaluation Module Kit was plugged into a USB extension cord and
placed next to the TI Design hardware for optimal data packet reception performance. A Rotronic© HC2-S
precision humidity and temperature probe (http://www.rotronic.com) and Rotronic Hygro Flex HF53
transmitter was used to provide reference relative humidity and temperature measurements. The test
setup is shown in 図 17.

図 17. Relative Humidity Test Setup
The relative humidity was then programmed to run a pre-defined profile. This profile set the initial chamber
humidity to 20% and soaked the TI Design hardware for an initial 40 minutes. The relative humidity was
then ramped up to 30% at a controlled rate over 10 minutes and then soaked at that humidity level for 20
minutes. This process was repeated up to the maximum tested relative humidity of 70%, then decreased
similarly to the minimum humidity level of 20%, and then soaked for 40 minutes to end the test. The
temperature during this profile was held to a set point of 45°C.
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図 18 shows the measured relative humidity from the HDC1000 device over the duration of the test as well
as the reference relative humidity from the Rotronic HC2-S precision humidity and temperature probe.
These results show the HDC1000 device tracks the reference relative humidity very closely.
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図 18. HDC1000 Measured Relative Humidity Data and Reference Relative Humidity Data

注:

The HDC1000 was used for the Relative Humidity testing. The HDC1010 has the same
functionality and pinout as the HDC1000 but is not an exact equivalent.
Testing using the HDC1010 will be done at a later date.
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Temperature Characterization
This TI Design exemplifies the concept of a duty-cycled sensor end node through the use of the HDC1010
device, which measures both relative humidity and temperature.
To get an idea of how the TI Design system responded to varying temperatures, the hardware was placed
in a TestEquity 1007H Temperature/Humidity Chamber (http://www.testequity.com/products/1104/) with a
brand-new Energizer CR2032 lithium-ion coin cell battery. Two test wires were routed outside the
chamber to a Keysight (Agilent) 34401A DMM with 6½ digits of resolution for monitoring of the V_BATT
voltage net. The CC2540EMK-USB CC2540 USB Evaluation Module Kit was plugged into a USB
extension cord and placed next to the TI Design hardware for optimal data packet reception performance.
The test setup is shown in 図 19.

図 19. Temperature Test Setup
The temperature was then programmed to run a pre-defined profile. This profile set the initial chamber
temperature to 25°C, and soaked the TI Design hardware for 10 minutes. The temperature then ramped
up to 35°C at a controlled rate over five minutes, and then soaked at that temperature for 10 minutes. This
process was repeated up to the maximum temperature of 60°C, and then decreased similarly to the
minimum temperature of –30°C. Finally, the temperature was increased back to 25°C using the same
controlled method. Relative humidity was allowed to vary during the temperature test, much as a realworld environment would respond.
The HDC1000 output data was recorded using the CC2540EMK-USB and Packet Sniffer software
combination described in 5.3.
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図 20 shows the environmental chamber set-point and the measured temperature from the HDC1000
device over the duration of the test. As is clearly seen, the HDC1000 device tracks the chamber
temperature very closely.
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図 20. HDC1000 Measured Temperature Data and Environmental Chamber Set Point

注:

The HDC1000 was used for the relative humidity testing. The HDC1010 has the same
functionality and pinout as the HDC1000 but is not an exact equivalent.
Testing using the HDC1010 will be done at a later date.

Due to the nature of CR2032 lithium ion coin cell battery chemistry, the output voltage can drop slightly
(tens to hundreds of millivolts) at lower temperatures. However, if all components in the system work
throughout the lifetime operating voltage of the coin cell, this should not be an issue for proper operation.
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CC2650 Radio Transmission Range
A brief transmission range test was performed with the TI Design hardware to get a rough approximation
of transmission range. The test was done inside a commercial office building hallway, with the TI Design
hardware placed at one end of the hallway on top of a fabric-covered metal chair. The hallway is
approximately 8 feet, 5 inches wide, a dropped ceiling 10 feet high, and a length of approximately
430 feet. There were not any significant obstacles in the hallway during the test.
A laptop with the CC2540EMK-USB and packet sniffer software was placed at varying intervals from the
TI Design hardware to test if the data packet successfully receivable. During the test, there was an
abundance of undesirable Bluetooth Smart packets received from the multitude of mobile phones in the
vicinity. However, the display filter setting on the packet sniffer software was set to only show data packets
from the TI Design hardware.
Packets received when the sniffer setup was in close proximity to the TI Design hardware were received
with a received signal strength indication (RSSI) of approximately –30 to –35 dBm. Packets received when
the sniffer setup was at the end of the hallway (~430 feet away) from the TI Design hardware were
received reliably with an RSSI of approximately –65 to –75 dBm. Packets beyond the end of the hallway
were not reliably received by the packet sniffer setup.
This TI Design was able to successfully transmit data packets down the entire length of a 430-foot hallway
with minimal obstructions. However, radio performance will likely vary in the end-equipment environment,
because obstructions in the RF transmit path will reduce range. For full verification of the TI Design
hardware transmitting characteristics, further testing with end-equipment context is required.
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Schematics
To download the schematics, see the design files at TIDA-00374 Schematics.
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図 21. Humidity and Temperature Sensor Node for Star Networks Enabling 10+ Year Coin Cell Battery Life Schematic
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7.2

Bill of Materials
To download the bill of materials (BOM), see the design files at TIDA-00374 BOM.

7.3

Layout Guidelines
To ensure high performance, the Humidity and Temperature Sensor Node for Star Networks Enabling 10+
Year Coin Cell Battery Life TI Design was laid out using a four-layer PCB. The second layer is a solid
GND pour, and the third layer is used for power rail routing with GND fills in unused areas. The top and
bottom layers are used for general signal routing and also have GND fills in unused areas.
For all of the TI products used in this TI Design, ensure that care is taken to adhere to the layout
guidelines given in the respective datasheets.

7.3.1

Layer Plots
To download the layer plots, see the design files at TIDA-00374 Layer Plots.

7.4

Altium Project
To download the Altium project files, see the design files at TIDA-00374 Altium.

7.5

Gerber Files
To download the Gerber files, see the design files at TIDA-00374 Gerber.

7.6

Assembly Drawing
To download the assembly drawing, see the design files at TIDA-00374 Assembly Drawing.

7.7

Software Files
To download the software files, see the design files at TIDA-00374 Firmware.
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のいずれかをダウンロード、アクセス、または使用した場合、お客様(個人、または会社を代表している場合にはお客様の会社)は、これら
のリソースをここに記載された目的にのみ使用し、この注意事項の条項に従うことに合意したものとします。
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訂正、拡張、改良、およびその他の変更を加える権利を留保します。
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策を行う目的での、安全策を開発し実装するために必要な、すべての技術を保持していることを表明するものとします。お客様は、TI製品
を含むアプリケーションを使用または配布する前に、それらのアプリケーション、およびアプリケーションに使用されているTI製品の機能
性を完全にテストすることに合意するものとします。TIは、特定のTIリソース用に発行されたドキュメントで明示的に記載されているもの
以外のテストを実行していません。
お客様は、個別のTIリソースにつき、当該TIリソースに記載されているTI製品を含むアプリケーションの開発に関連する目的でのみ、使
用、コピー、変更することが許可されています。明示的または黙示的を問わず、禁反言の法理その他どのような理由でも、他のTIの知的所
有権に対するその他のライセンスは付与されません。また、TIまたは他のいかなる第三者のテクノロジまたは知的所有権についても、いか
なるライセンスも付与されるものではありません。付与されないものには、TI製品またはサービスが使用される組み合わせ、機械、プロセ
スに関連する特許権、著作権、回路配置利用権、その他の知的所有権が含まれますが、これらに限られません。第三者の製品やサービスに
関する、またはそれらを参照する情報は、そのような製品またはサービスを利用するライセンスを構成するものではなく、それらに対する
保証または推奨を意味するものでもありません。TIリソースを使用するため、第三者の特許または他の知的所有権に基づく第三者からのラ
イセンス、あるいはTIの特許または他の知的所有権に基づくTIからのライセンスが必要な場合があります。
TIのリソースは、それに含まれるあらゆる欠陥も含めて、「現状のまま」提供されます。TIは、TIリソースまたはその仕様に関して、明示
的か暗黙的かにかかわらず、他のいかなる保証または表明も行いません。これには、正確性または完全性、権原、続発性の障害に関する保
証、および商品性、特定目的への適合性、第三者の知的所有権の非侵害に対する黙示の保証が含まれますが、これらに限られません。
TIは、いかなる苦情に対しても、お客様への弁護または補償を行う義務はなく、行わないものとします。これには、任意の製品の組み合わ
せに関連する、またはそれらに基づく侵害の請求も含まれますが、これらに限られず、またその事実についてTIリソースまたは他の場所に
記載されているか否かを問わないものとします。いかなる場合も、TIリソースまたはその使用に関連して、またはそれらにより発生した、
実際的、直接的、特別、付随的、間接的、懲罰的、偶発的、または、結果的な損害について、そのような損害の可能性についてTIが知らさ
れていたかどうかにかかわらず、TIは責任を負わないものとします。
お客様は、この注意事項の条件および条項に従わなかったために発生した、いかなる損害、コスト、損失、責任からも、TIおよびその代表
者を完全に免責するものとします。
この注意事項はTIリソースに適用されます。特定の種類の資料、TI製品、およびサービスの使用および購入については、追加条項が適用さ
れます。これには、半導体製品(http://www.ti.com/sc/docs/stdterms.htm)、評価モジュール、およびサンプル(http:/
/www.ti.com/sc/docs/sampterms.htm)についてのTIの標準条項が含まれますが、これらに限られません。
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